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Starting Visual Studio 2019

• Visual Studio is installed on PCs in L117.  
Otherwise, you have two options:

1. Download and install Visual Studio 2019 
Community edition:

https://visualstudio.microsoft.com/downloads/

This is the preferred option, because it installs 
Visual Studio on your PC (or Mac).
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Starting Visual Studio 2019

• Two options:

2. Use Apps Anywhere:

https://its.niagaracollege.ca/apps-anywhere-
instructions/

“Apps Anywhere is available as the preferred 
software option for all students and faculty with a 
Windows based computer. ”
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Starting Visual Studio 2019

• The following slides refer to using a native 
installation of Visual Studio on a Windows 10 
PC.

• See the Appendix for starting Visual Studio 
with Apps Anywhere.
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Starting Visual Studio 2019

• From the Windows 10 Start Menu …
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The “splash screen” is shown while Visual Studio loads … 

it may take several seconds.
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Visual Studio 2019

Note:  You may see the “Dark” colour theme (the default.)  It can be changed…
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Create A New Project (Alternate Ways)

• From the File menu, select New, then Project…

• You can also press Ctrl+Shift+N instead

1

2 3
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The “Create a new project” dialog box appears

For every program we do in this course, the Language is C++, the platform is 

Windows, the project type is Console, and the project template is Empty
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The “Configure your new project” dialog box appears

Every program we do in this course will have its own folder.  You are

responsible for keeping track of your files!
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Step 1. Choose the Project Location

• Click on the “browse” button to pop up the “Project Location” dialog box.  
From here, choose or create a folder in which to store your projects.  

• Each project will have its own subfolder.

• If you choose to save projects on drive C:, it will be faster, BUT you need to 
back up those folders!

• I recommend the following (in order of preference):
1. Your own USB hard drive or SSD (fast);
2. Your “One Drive – NC” – if available (automatically copied to the Cloud);
3. Your own USB flash drive (slowest option).
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Step 1. Choose the Project Location

• If you are working in L117, choose the SSD 
(solid state drive) – D: or E:, depending on 
which Windows 10 installation you started.

• When you are finished, make sure that you:

1. Copy your files to your own USB and/or your 
One Drive NC, so that you have a copy;

2. Delete your files from the SSD, so that others
cannot copy your work!
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Step 1. Project Location Examples

• In the example on the left, I have chosen 
C:\2020F\ctec1332\src as the main folder 
for all my Visual Studio projects.

• In the example on the right, I have chosen my 
OneDrive, and created a “2020F” folder, then a 
“ctec1332” subfolder, which will be the main 
folder for projects.
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Step 2.  Give the Project a Name

• The name will be used for both the project 
folder and the executable.

– For example, for the C++ Console app above, the 
project folder will be Hello and the executable will be 
written to Hello\bin\Debug\Hello.exe
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Step 3.  One Directory Only

• Visual Studio allows you to create multiple
Projects within a single Solution.

• In this course, we will have exactly one Project 
per Solution, so to simplify things, only one 
folder is needed.
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Step 4.  Create the Project
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Step 4.  Create the Project
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• For example, for the Empty C++ Windows 
Console app above, the project folder will be 
C:\2020F\ctec1332\src\Hello and the 
executable (Application) file will be 
C:\2020F\ctec1332\src\Hello\Debug\Hello.exe



New Project Created

Visual Studio creates an “Empty” project, meaning that you have to add a 

source code file. 

Type in code here
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Empty Project Folder

There are four files and one hidden directory.  

Copy a source code (.c) file here, using either File Explorer or

the Command Prompt.  

A template .c file is always here:

http://technology.niagarac.on.ca/courses/ctec1332/template.c
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Copy the Template File
I downloaded the template.c file to my Project Location folder 

(C:\2020F\ctec1332\src), so that it is always ready to be copied to a new 

project.  
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To copy
the file, 
from a 
Command 
Prompt:



Copy the Template File
I downloaded the template.c file to my Project Location folder 

(C:\2020F\ctec1332\src), so that it is always ready to be copied to a new 

project.  
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To copy the file, from a Command Prompt:

Change to Project Location folder

Copy to Project Name folder



After Copying
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Hidden folder 
(DO NOT TOUCH)

VS2010
Project
Files 
(D.N.T.)

Source file
(CODE GOES 

HERE)



A Better Way: 
Copy and Rename the Template File
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To copy and rename the file (using a single command):



Add the Source Code file to the Project

• Visual Studio keeps track of your project contents in the Solution 

Explorer pane.

• In our Empty project, there are no Source Files.

• Right click on Source files to add your copied template file.
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Add the Source Code file to the Project

• Add > Existing Item… (or 

Shift+Alt+A) will open a 

browser window in the 

project folder itself.

• Click on the .c (C Source) 

file, then Add
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C Source File Added

• Double click on the .c file (here it is called “hello.c”) to open it 

in the Editor pane.

• This can be done if you re-open the project at a later date and 

want to edit the code.
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Start Coding!

My template contains instructions in the form of C comments to guide

you where to put various things to complete your program…

Type in code here
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Hello, Cruel World
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Hello, Cruel World
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Comment
block

Library includes

Program code



C Console App Code

• The C #include (pre-processor) directive 
allows the program to use various aspects of 
the Standard C Library.

• The program entry point is “main”.

• The main function contains C code between 
the braces, concluding with a return
statement.
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Build and Run:  Press F5
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Type in code here

On success, a Debug Console
window appears with the program
output

On success, the Output pane shows that the 
“program exited with code 0”

On failure,
the Error List
pane would 
show build 

errors



Project Files After Build

• Don’t mess with the .sln or .vcxproj files!

• The Debug folder is used for building -- it contains 
the executable.

• Later, the Debug folder can be safely deleted.
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Debug Files After Build

• The executable file (called Hello.exe here) is now a 
Windows Application, and can be copied elsewhere, 
including to other Windows computers.

9/8/2021 Visual Studio 2019 Projects 33



C Console Executable

• The executable is 
built (linked) in the 
Debug folder; it has 
an .exe extension.

• You can run it 
directly from the 
command line.

• This file can also be 
copied to most other 
Windows computers 
by itself.
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Cleaning C Projects – Method 1

• From the Build menu, choose Clean Solution.

• From the File menu, choose Close Solution.
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Cleaning C Projects – Method 2

• From the File menu, choose Close Solution.

• From a Command Prompt:
– cd to the project folder (e.g., cd Hello)

– rd /s /q Debug

– cd .vs

– cd <project-name> (e.g., cd Hello again)

– cd v16

– del Browse.VC.db

– rd /s /q ipch

– cd ..\..\..\.. (or cd .. four times)
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Cleaning C Projects – Method 2
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Archiving the Project

If 7-Zip is installed, you can simply right-click on the project folder in

Windows Explorer and create an archive (.7z or .zip) file.  (This example

was done under Windows 10 in L102.)

The project folder and 

resulting 7-Zip archive file 

(both on Desktop)
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Archiving the Project - Summary

• Follow the cleaning procedure.

• Using Windows Explorer, go to the folder 
where your project folder is

• Right click on the project folder and select 7-
Zip and then “Add to ____.7z” (where ____ is 
the name of your project/project folder)

• A .7z archive file will be created, which you 
can either copy to a USB device, to your 
OneDrive, safely email, and/or post on BB.
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Archiving the Project - Summary

• If you use Cleaning Method 1, then the size of 
the .7z file will be around 500 kB.

• If you use Cleaning Method 2, the size will be 
around 5 kB!

• If you don’t have 7-Zip, you can use Windows 
zip instead:  right-click, Send To > Compressed 
(zipped) Folder
– Around 900 kB using Method 1

– Around 7 kB using Method 2
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Archiving the Project - Summary

• You can also use File Explorer or a Command 
Prompt to make a backup of your project:
– e.g., 
robocopy Hello c:\Backups\Hello /e

• This creates an identical copy of the entire 
project folder:
– about 5 MB uncleaned

– about 4 MB cleaned using Method 1

– about 50 kB cleaned using Method 2
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Archiving the Project - Summary

• Either way, remember the 3-2-1 Backup Rule:

– 3 copies (your C: drive, a USB, your OneDrive)

– 2 different media (HD, SSD, Flash, “The Cloud”)

– 1 offsite copy (OneDrive, email, BB)
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CUSTOMIZING VISUAL STUDIO
APPENDIX
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Customizing Visual Studio

• From the Tools

menu, select 

Options (right at the 

bottom).  

• You can then change 

the Color theme, and 

make the font 

larger…
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Customizing Visual Studio

Change the Color theme to Light (or Blue) for better contrast…

9/8/2021 Visual Studio 2019 Projects 45



Customizing Visual Studio
From Fonts and Colors, the default font is already Consolas.  You can

make it larger for more detail on screen.
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USING APPS ANYWHERE
APPENDIX
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Apps Anywhere
• Read the Guide and follow the steps:

https://its.niagaracollege.ca/wp-content/uploads/AppsAnywhere-

Guide.pdf

• You need to download and install the Cloudpaging Player

first:

https://appsnc.niagaracollege.ca/

• From the Niagara College Portal, go to All Applications:

https://portalnc.niagaracollege.ca/MyApplications

(Apps Anywhere is the first icon)

• In the Player, Visual Studio Community Edition 2019 near the 

bottom of the list…
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Apps Anywhere
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Important!  Use your One Drive – NC folder to save projects.


